VideoGUI:

A Benchmark for GUI Automation
from Instructional Videos



Motivation: Simple Vision Task @& Complex Computer Task

1. VLMs (Vision-Language-Models)
o CLIP, Flamingo, LLaVA

;ﬁS:OUtput: text

- Pretrained and frozen

Trained from scratch a very serious cat.
during Flamingo training
| — *
Perceiver Perceiver [T n-th GATED XATTN-DENSE
Resampler Resampler

|

1st GATED XATTN-DENSE

L.

Experts in specific vision tasks
with Large-scale pretraining

Processed text I

image> This is a very cute dog. <image> This is

Input: text and visual
data interleaved

This is a very cute dog. | &

5

Visual data
processing

Figure 3 | Overview of the Flamingo model. The Flamingo models are a family of visual language model
(VLM) that can take as input visual data interleaved with text and can produce free-form text as output. Key to
its performance are novel architectural components and pretraining strategies described in Section 3.



Motivation: Simple Vision Task @& Complex Computer Task

1. VLMs

2. Multi-modal Agent
o MM-ReAct, ViperGPT, AssistGPT

@ I am trying to create a short version of the video, can you suggest a shorter segment for each step?

Here's a suggested shorter segment for each step:
1. Heat a little olive oil in a pan and grill the tomatoes: 00:00:24 - 00:00:30
Cook the bacon in a frying pan: 00:00:53 - 00:00:59
Place the cooked bacon on a paper towel: 00:01:39 - 00:01:41
Spread mayo and add Worcestershire sauce: 00:02:00 - 00:02:08
Assemble the sandwich (lettuce, tomatoes, bacon): 00:02:44 - 00:03:01
a.  Layer lettuce: 00:02:44 - 00:02:47

e Solve complex vision tasks
with LLM reasoning

Ul B 0N

6.  Sprinkle salt and pepper: 00:03:08 - 00:03:11
7.  Top the sandwich with the other slice of bread: 00:03:29 - 00:03:34

;i«* <,

5b.Add Tomato . Sc.Place Bacon 6.Sprinkle Salt/Pepper g

5a. Layer Lettuce



Motivation: Simple Vision Task @& Complex Computer Task

1. VLMs

2. Multi-modal Agent
3. Actionable Model / Agent

O CogAgent, MM-Navigator, AssistGUI

% User: Could you guide me through the steps to “search for the best paper in CVPR 2023”?

=/

CogAgent: Move the
cursor to the Google
Search box located
approximately at the
center of the screen,
then type 'best paper in
CVPR 2023'.
[Operation]:
[searchbox] Search ->
TYPE: best paper in
CVPR 2023 at the box
[[250,479,750,540]]

——-

CogAgent: Click on

*  the area of the screen

that corresponds to the
'CVPR 2023 Best
Paper Award Winners
Announced' link to
navigate to the details
of the winning papers.
[Operation]: [div]
CVPR 2023 Best
Paper Award Winners
Announced -> CLICK
at the box
[[168,775,656,829]]

2)

Google

CVPR 2023 Best Paper Award Winners Announced

Computer Agent

CogAgent: Press the
enter key on the
keyboard while the
cursor is inside the
Google Search box to
initiate the search for
'best paper in CVPR
2023'.

[Operation]:

Press Enter

B ———

CogAgent: Move the
cursor over the box that
represents the link for
'Best Paper: Visual
Programming:
Compositional visual
reasoning without
training', and click.
[Operation]: [link] Best
Paper: Visual
Programming:
Compositional visual
reas... -> CLICK at the
box [[087,675,817,695]]

Interact with environment
by actions

GUI (Graphical user
interface) being the most
representative
environment



Motivation: Existing GUI benchmarks

® Existing GUI benchmarks
o Simple Task can be clearly described by textua/ query

= B 1 [ .

' Enter Focused mode : Fill in sheet, draw char'r

Andy McKee - Rylynn -‘ @

Mass vs. Acceleration Scatter
Chart

OS-Copilot

g sne

2 gD Fuwe U
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-

868 etagtvany o=

— o

1. Adjust work layout and theme. ' 1. Calculate and fill out the spreadsheet. | 1. Generate the files required.
2. Play music. . 2. Draw a bar chart. . 2. Compile and build to the webpage.

Credit to OS-copilot (2024)



Motivation: Existing GUI benchmarks

e Complex Task by

o Visual Query e.g., How to create such effect in Powerpoint?

Challenging 1: Reverse Engineering from Vision Preview


http://www.youtube.com/watch?v=F2Enf6tjmy8

Motivation: Existing GUI benchmarks

e Advanced Need

o Visual-centric Query e.g., How to create such effect in Powerpoint?

I © O © ) @ Simple and Professional X 4+ - o X
e ) @) httpsy//www.youtube.com/watch?v=F2Enf6tjmy > AN G m R - 9
= OVouube a ¢ ® 3 e

L 4
o
P
(<]
@
w
&
-

§ Operator anagement .
Simple and Professional PowerPoint Slide | Tutorial 1029 | Free Template d d I t
+  POWERPOINT UNIVE Q o %2 . INFOGRAPHIC IN LESS THAN. u a n r p rO u C r S u
S
Creative._templates #PowerPoint_Infographics #PowerPoint_University ~ @z 53

Human Learning from Web Instructional Videos
Challenging 2: Long Procedural & Multiple Actions



http://www.youtube.com/watch?v=F2Enf6tjmy8

What’s New on VideoGUI?

‘\ \Crean e.g., R/unway D00 Visual-centric Software
B =4of}
e i 2R + ] i
F2 . o do//y 200 effect, WhC(T'S new on G & runway o Stable Diffusion
VideoGUI? Media Creation, Editing, AT tools
e Editing e.g., PhotoShop 1. Novel Softwares
e = o Media creation, editing, browsing
o Al Tools
remove
background

e Browsinge.g., Download a video from mixkit.co

wamit

a
L ] i
o
Free assets for your next video project : - :
.

‘Firefox
=T = [ -—u i mixkit-white-cat-
SIS LS d (2. B Populerstockfootoge cotegories QREED lying-among-the
o [ I s S
[ ] _rlAca_ 2272


http://drive.google.com/file/d/1enmWNa6zESIu1xdhQPa_szGaS_lhVrNh/view

What’s New on VideoGUI?

Tasks from Instructional Videos

Tutor's Instructions

\ Goal: How to create this effect in PPT2 /

2. Novel Tasks

| —_ A Visual-centric Software

Cl o@emesns

Wha_rus new on & runway o Stable Diffusion
VIdE.OGUI? Media Creation, Editing, AT tools

O Source from Inst. Video e.g., interactive editing in DALLE-3?




What’s New on VideoGUI?

Visual-centric Software

= BEROOA

Tutor's Instructions

What's new on $ [B ruany o Stable Diffusion

\._Goal: How to create 'ris effect in PPT? / VideoGUI?

Media Creation, Editing, AI tools
Watching r _ T _ ____________ I
° h - I @ Instructional video | [H'Qh‘leve'l Plﬂﬂnlng] l
A. Insert the letters "Jungle' and merge them together as a pattern.
3 ° H I e ra rc I ca Human i B. Insert a black rectangle to cover the letters and apply subtract on these |
Demonstrations I letters to create a mask. Insert a Forest figure as background. I
An n otatio n S ] C. Insert the animation 'lines curve' and adjust the parameters. ,
— y;
[Middle-level A-33. Key board Type Ctrl + A B-1. Click on 'Jungle' letter C-1. RightClick on Rectangle
H |gh _| evel P | ann | ng Planning] A-34. Click on Shape Format B-2. Click on Shape Format C-2. Click on Format Shape Reproduced
A-1. Click on Insert A-35. Click on Merge Shapes results
A-2. Click on Text Box _ A-36. Click on Union B-12. Click on Subtract Shapes  C-28. Drag slider to decrease Smooth start duration
-
Mid-level Planning _ 0
e @) &
e Insert D !
' i
Atomic-action Exec. [Atomic-action Execution] - Action: RightClick Action: Drag
. . Action: Type / Press LT
Action: Click  Element: Insert Element: Ctrl + A Element: Rectangle Element: slider of Smooth end

Coordinate: [208. 1001 Coordinate: [1622. 983] Coordinate: [468, 344] to [281, 346]



How we VideoGUI collect

(i). Video
Selection

(ii). Human
Demonstration

ﬂ t (iii). Manual
=—| Annotation

Figure 2: Illustration of pipeline, encompassing four p

©

¢/

(iv). Review &
QA Creation

hases: (i) High-quality instruction videos are manually

selected. (ii) Participants replicate skills demonstrated in videos. (iii) Participants annotate task elements and
procedures. (iv) Annotated data is validated manually for use.

Human demonstration data collection pipeline

User Recorded Video Action Caption
& > =
o —
Demonstration Key.log Captioning
G‘LP % — nHuman label —T
P~ LR LR R .

cursor click on (1,23)
cursor release (1,23)
key 'd

cursor click (45, 56)

cursor release (78, 90)1

Windows Environment

e OBS studio

- — = = ==

¥ Acton Recorder

Instruction: The pair of images below shows the screenshot before and after the action, add the caption in the box blow

Us SUBMARINE
DAY

Here b where yau fresaraton boges

iii.lUBMARINE
- SR

Hero & mhere you presentaton begns




VideoGUI Hierarchical Annotations

Video preview

Start ::> End

Full task

High-level Plans

® Mid.-level Plans

® Atomic Actions

Visual query: How to trans-
form from [start] to [end] in
Premiere Pro?

Textual query: Change the
blue sky in the background of
the picture to the red color at
sunset.

b. Get the color of the back-
ground

¢. Adjust the track order to the
second track

d. Add the new background
photo to the first video track;

al. Click on Effects panel
a2. Click on search bar in Ef-
fects panel

a3. Key board Type ‘ultra’

a4. Click on ‘Ultra Key’

aS. Drag Ultry key effect from
effects panel to the video. (Pur-
pose: add ultra key to the
video)

al. Click, [216, 996]




VideoGUI Statistics

Benchmark # Task Platform Source _Quexy format form?t # A.vg. EV?I' dlmensmr?
Text Image Video Action Task SR. Hier. Plan. Action Exec.
Mind2Web [6] 2350 Web Screenshot v 1.3 v v
PixelHelp [20] 187 Android Emulator v 4.2 v v
AITW [10] 30K Android Emulator v 6.5 v v
AssistGUI [21] 100 Windows Web Video v - v
OSWorld [22] 369  Win.+Ubuntu Emulator v - v
V-WebArena [23] 910 Web Screenshot v v - v
3 SUBTASK | 463 5 Video + Human 5.6 _
VideoGUI FULLTASK| 86 WYL EWED Demonstration 4 v v 22.7 v / 4
0.3 = Full task
A
0.95 B Sub. task K3
I
2 %
0.2 c %
0.15 Click
66.2%
0.1 Scroll
2.36% T
0.05 RightClick
2.03%
0 - [
20 40 60 80 100 120
(a) Dist. of Software taxonomy. (b) Num. of Action per task. (c¢) Dist. of Atomic actions.

Figure 3: Data statistics of VideoGUI.



How to Evaluate such Complex Task?

® 0/ 1 Success Rate?
O Easy to be 0 and fail to receive enough signal

Success

Click to add title

Fail



How to Evaluate such Complex Task?

® Hierarchical Assessment

O Procedural Planning
m High-level
m  Mid.-level
O Atomic Action Execution
m Click, Drag, Type / Press, Scroll



How to Evaluate such Complex Task?

e Hierarchical Assessment & Multiple Settings
O Procedural Planning — LLM Eval (e.g., MM-Vet style) to overcome subjectivity

m  High-level: Visual Preview ¢ = Milestones
m  Mid.-level: Milestone ¢ = Action Narration Sequence

§ X
=

[Visual output]

Textual query:

Insert the title effect ‘Clean
and Simple Lower Third’
with text ‘The cat scared the
dog away’ at the beginning
of the “cameraB” video;

5 “J.cma¥xo - van Y

[Visual init state]

High-level Planning:

How [Visual input] to [Visual output]?

GT:

A. Insert the title effect ‘Clean and Simple Lower Third’
with text ‘The cat scared the dog away’ at the beginning of
the first clip.

B. Make the second clip color warmer by moving the
gamma value closer to orange;

Middle-level Planning: [Init state] + Text
GT:

Al. Click on Effects

A2. Click on Titles

A3. Drag Clean and Simple Lower Third from original position to the
beginning of the cameraB.mp4. (Purpose: insert the title effect)
A4. Click on Inspector

AS. scrollup 5

A6. Drag SAMPLE TEXT from the last letter to the first letter.
(Purpose: select all text)

A7. Key board Type “The cat scared the dog away’



How to Evaluate such Complex Task?

e Hierarchical Assessment & Multiple Settings

O Action Execution (4 type)
o Click; Drag; Type / Press; Scroll

- begin

Action-level

GT: UP

~cef€ga

2. Scroll:JShoulLd'I scroll up / (iO\'A;n / not to find the

GT: [289, 66]
text box?

Clean and Simple Lower Thir|

Controls

GT:
The cat scared
the dog away

v Text

SAMPI F TEXT

3. Drag: How to drag SAMPLE TEXT GT_Start: [1645, 393] 4. Type / Press: Please type </>
“The cat scared the dog away” Env. Monitor

from the last letter to the first letter. GT _End: [1415, 381]



How to Evaluate such Complex Task?

e Hierarchical Assessment & Multiple Settings
O Procedural Planning

m High-level: Visual Preview ¢ Milestones
m  Mid.-level: Milestone ¢ = Action Narration Sequence

=) ussusMmARINE = US SUBMARINE
Visual [Hardest]: How == "‘“»- to = e
’j 'i US SUBMARINE =
Visual + Text: Based = _PAY , Swap the first ppt and the second ppt

. s VIS eaedeNe Ticeeim=ha

Text: Swap the first ppt and the second ppt



Action Metrics — Click / Drag — Grounding

e Human GT: point [x,y] 7] pred box
e Model Predictions: /o

o Boxes: CogAgent, Qwen-VL-Max Click ///j:// A

O Points: GPT-4-SoM @"” Pred point
® Metrics B bt

O Distance
O Recall@r

T o“_” O c U e.g., drag the the dog to top-left

Drag is more strict and requires
both start and end are satisfied




Action Metrics — Key / Press — Coding

Query ——1{ Model

|, Code writing

I'm working on a computer task
involving typing or pressing keys.

Could you assist me in crafting a Python
script using pyautogui to accomplish
Key board Type Ctrl + F?

I've already set up the environment.
Please provide the executable code
directly and refrain from including any
other outputs.

(pyautogui)

Certainly! Here is the Python script
using pyautogui to simulate pressing
Ctrl + F:

" "python

import pyautogui

# Press and hold the 'ctrl'
key
pyautogui.keyDown ('ctrl')

# Press the 'f' key
pyautogui.press('f')

# Release the 'ctrl' key
pyautogui.keyUp('ctrl')

,\' Monitor Recall: 1

(pynput) Prec: 1/2

Code Executing...
Output: ['ectrl 1', 'ctrl+f']
GT: ['ctrl+f']

Figure 2: Illustration of how we evaluate the key / press action.



Action Metrics — Scroll — Multiple-Choice Question

Before Scrolling, we assume that
[the target element] is not within the screenshot.

Question: Should | scroll to find the maiandra GD
button?
Answer: Scroll Up / [ ] Scroll Down / No need

Lucida Sans Ty
Lucida Sans Unicod

‘ Magnoto
Maiandra GD
Mal ,,

Maiandra GD

Malgun Gothic Semiligl
Mangal

Pre B emS S oty ~ @ D00 3%

After Scrolling, we assume that
[the target element] should be inside the screenshot.

Next Action: Click [the Maiandra GD button]

Question: Should | scroll to find the maiandra GD
button?
Answer: Scroll Up / Scroll Down /[ ] No need



Baseline Models

e Model scope

O Text LLM / Multi-modal LLM (1f or >1f)

® [nterleaved Instructions
O Text/Image / Image+Text / Image Pairs / Video / Video+Text / Video Pairs

Model

Support Interleaved Instructions?

VideoGUI Evaluation (%)

Text  Imgae (1f) Media(> 1f) High Plan Mid. Plan Action Overall
LLama3-70B [43] v . 40.5 20.3 20.3
Mixtral-8x22B [44] v - 36.0 19.6 18.6
GPT-3.5-Turbo [42] v - 49.1 22.3 23.8
CogAgent [19] v v 4.4 21.8 7.4 17.6
Qwen-VL-Max [41] v v v 5.1 35.7 289 27.7
Gemini-Pro-V [40] v v v 7.9 28.6 23.8 14.8
Claude-3-Opus [39] v v v 9.7 45.6 394 38.7
GPT-4-Turbo [36] v v v 14.3 52.9 34.4 34.9
GPT-40 [36] v v v 17.1 53.5 47.6 50.6




Results on Procedural Planning

2. With clear text description, gpt3.5 or open-

source is sufficient for planning

Model

High-level Planning (0 — 5)

Middle-level Planning (0 — 5)

Vision Text Vision & Text Vision Text Vision & Text

LLama3-70B [43] - 2.62 - - 2.02 —

Mixtral-8x22B [44] - 2.43 - - 1.80 —

GPT-3.5-Turbo [42] - 2.67 - - 2.46 —

CogAgent [19] 0.22 1.12 1.23 - 1.32 1.09
Qwen-VL-Max [41] 0.25 2.30 1.96 0.70 1.72 1.79
Gemini-Pro-Vision [40] 0.39 2.35 1.45 0.34 1.61 1.43
Claude-3-Opus [39] 0.48 2.54 2.17 0.66 2.26 2.28
GPT-4-Turbo [36] 0.71 2.57 2.55 1.49 2.57 2.65
GPT-40 [36] 0.86 2.68 2.46 1.78 2.45 2.68
Avg. by models 0.49 2.37 1.97 0.99 2.02 1.98

1. Query by visual-preview is extremely
challenging; High-level is harder than

middle-level

3. Vision & Text is even poor than Text-only,
Calling stronger Interleaved Multi-Modal
understanding



Results on Action Execution

Modil Grd? _ 1. Click . 2. Drag 3. Type/Press 4. Scroll Action

Dist. | Recall T Dist. | Recall 1 Recall Prec. Acc. Full
Random - 49.9 0.7 47.2 0.0 ~ - 31.3 8.0

LLMs
LLama3-70B [43] - - - - - 849  81.3 - 20.3
Mixtral-8x22B [44] = = = " " 8.6 785 | Keyboard 96
GPT-3.5-Turbo [42] [42] - - - - - 93.1 895 | js-easy, 22.4
Multi-modal LLMs Text LLM is okey
CogAgent [19] v 30.9 3.4 44.7 0.0 - - 26.6 1.5
Qwen-VL-Max [41] v 46.8 0.0 42.0 0.3 84.3 73.0 42.2 28.9
Gemini-Pro-Vision [40] 40.7 5.0 40.8 0.0 86.4 82.2 7.8 23.8
Claude-3-Opus [39] 30.7 7.0 30.6 1.7 92.5 88.1 60.9 394
GPT-4-Turbo [36] 23.8 10.0 3 1.4 92.3 88.8 31.5 344
GPT-40 [36] 16.6 Y PS5 923 89.0 47.6
Modular methods: LLMs + Tools

GPT-3.5 4+ OCR [42] v 16.8 48.7 36.4 5:5 03.1 89.5 56.3 50.0
GPT-40 + OCR [42] ve 12.0 60.1 (+42.4) 25.7 11.3 (+8.8) 92.3 88.8 82.8 (+1.5) 56.3 (+8.7)
GPT-40 + SoM [33] v 15.7 359 (+18.2) 229 3.0 (+0.5) [92.3 88.8 89.0 177y 543 (+6.7)

GPT-4o0 is strong on visual perception, with resolution hint prompting even better than grounding model



Results on Action Execution

Model Grd? _ 1. Click . 2. Drag 3. Type/Press 4. Scroll Action

Dist. | Recall T Dist. | Recall 1 Recall Prec. Acc. Full
Random - 49.9 0.7 47.2 0.0 ~ - 31.3 8.0

LLMs
LLama3-70B [43] - - - - - 849  81.3 - 20.3
Mixtral-8x22B [44] - - - - - 82.6 78.5 - 19.6
GPT-3.5-Turbo [42] [42] - - - - - 93.1 89.5 - 224
Multi-modal LLMs
CogAgent [19] v 30.9 3.4 44.7 0.0 - - 26.6 1.5
Qwen-VL-Max [41] v 46.8 0.0 42.0 0.3 84.3 73.0 42.2 28.9
Gemini-Pro-Vision [40] 40.7 5.0 40.8 0.0 86.4 82.2 7.8 23.8
Claude-3-Opus [39] 30.7 7.0 30.6 157 92,5 88.1 60.9 394
GPT-4-Turbo [36] 23.8 10.0 313 1.4 92.3  88.8 31.5 344
GPT-40 [36] 16.6 17.7 21.9 25 92.3 89.0 81.3 47.6
Modular methods: LLMs + Tools

GPT-3.5 4+ OCR [42] v 16.8 48.7 36.4 5.5 03.1 89.5 56.3 50.0
GPT-40 + OCR [42] / 12.0 60.1 (+42.4) 25.7 11.3 (48.8) 92.3 88.8 82.8 (41.5) 56.3 (+8.7)
GPT-40 + SoM [33] v 15.7 359 (118.9y] 22.9 30 om 923 88.8 89.0 7.7y 543 (46.7)

Both OCR / SoM boost performance,



Ablations

e High-level planning scores by different software
e Mid.-level planning scores by action number

2 e,
© 1 +
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l S 05
0
0O J/ O
QO c jab) 0 O = —
= ® 2 = 0 10 20 30
S :
5 2 2 # Action / Task
- PPT s the easiest one; - Planning becomes more difficult as the number of
- Professional software like PS / AE are more challenging; actions increases.

- Runway and CapCut, which are web-based, still
relatively difficult to master.



Qualitative Results

High-level Planning (Final visual effect)
How to create such effect in Powerpoint?

GT:

1. Set up a blank slide with a gradient fill background

2. Insert a 3D model of a shiba lun dog and adjust its size and
position

3. Add a text 'Shiba Inu' in title box

. Duplicate the first slide

. Drag the title box to bottom with text 'Side view

5. Drag the dog to center and rotate to right

7. Apply the Morph transition to all slides;

[

o

GPT-4o0 [4]

1: Insert a 3D model of a Shiba Inu.

2: Add text 'Shiba Inu' and position it next to the 3D model.

3: Apply the 'Fly-in' animation to the 3D model from the left.

4: Add a second slide with a side view of the Shiba Inu 3D model.
5: Add text 'Side view' and position it below the 3D model.

6: Apply the '"Morph' transition between the two slides.

Gemini-Pro-V [2]

1. Insert a 3D model of a Shiba Inu dog.

2. Apply a "Rotate' animation to the dog, specifying the "Side" direction.
3. Insert a text box with the word "Side view" and position it below the dog.

Claude-3-Opus [2]

1. Insert an image of a Shiba Inu dog.

2. Add the text "Shiba Inu" next to the image.

3. Apply a 3D rotation effect to the dog image, rotating it from a side view to a front view.



Qualitative Results

High-level Planning (Final visual effect)
How to create such effect in Powerpoint?

GT:

1. Set up a blank slide with a gradient fill background

2. Insert a 3D model of a shiba lun dog and adjust its size and
position

. Add a text 'Shiba Inu' in title box

. Duplicate the first slide

. Drag the title box to bottom with text 'Side view

5. Drag the dog to center and rotate to right

(U i UL

o

GPT-4o0 [4]

1: Insert a 3D model of a Shiba Inu.

2: Add text 'Shiba Inu' and position it next to the 3D model.

3: Apply the 'Fly-in' animation to the 3D model from the left.

4: Add a second slide with a side view of the Shiba Inu 3D model.
5: Add text 'Side view' and position it below the 3D model.

6: Apply the '"Morph' transition between the two slides.

Gemini-Pro-V [2]

1. Insert a 3D model of a Shiba Inu dog.

2. Apply a "Rotate' animation to the dog, specifying the "Side" direction.
3. Insert a text box with the word "Side view" and position it below the dog.

Claude-3-Opus [2]

. Insert an image of a Shiba Inu dog.

1
7. Apply the Morph transition to all slides; 2.Add the text "Shiba Inu" next to'the image.. =~ _ :
3. Apply a 3D rotation effect to the dog image, rotating it from a side view to a front view.
=l L " == GPT-40 [5]
= == . Click the 'Insert' tab in the ribbon at the top of the screen.
. Click the '3D Models' button in the 'Illustrations’ group.
Select 'From Online Sources..." from the dropdown menu.
. In the search bar, type 'shiba inu dog' and press Enter.
. Browse the results and click on the desired 3D model of a shiba inu dog.
. Click the 'Insert' button to add the 3D model to the slide.
. Click on the 3D model to select it.
. Use the corner handles to adjust the size of the 3D model by clicking and dragging.
. Click and drag the 3D model to position it in the desired location on the slide.

. Liiteceme Pitiezen ® . Lriceceme “eviezzen

Init. visual state Final visual state

R I Y N

Middle-level Planning (Init. visual state + Text)

Insert a 3D model of a shiba lun dog and adjust its size and position Gemini-Pro-V [3]

1. Click the 'Insert' tab.

2. In the '3D Models' group, click the 'From File' button.

3. In the 'Insert 3D Model' dialog box, navigate to the folder containing the shiba inu
1. Click on Insert dog model.

2. Click on 3D Models 4. Select the 'shiba_inu.fbx' file and click the 'Insert’ button.

3. Click on Stock 3D Models 5. The shiba inu dog model will be inserted into the slide.

6. Click and drag the model to reposition it.

GT:

4_1' Kgybourd‘ l‘_\'p(‘ dog then P‘,l]ltr : 7. Use the 'Scale' tool to resize the model.

5. Click on Shiba-Inu dog with motion 8. Click the 'Format' tab.

6. Click on Insert 9. In the 'Shape Styles' group, click the '3-D Model Styles' button.

7. Drag the the dog to top-left 10. In the '3-D Model Styles' gallery, select the desired style for the model.
8. Drag the the lower right corner to enlarge the dog 11. Click the 'Close' button to close the 'Format Shape' dialog box.

12. The shiba inu dog model will be updated with the selected style.



Qualitative Results
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Using GPT-40 to build a mini Agent
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Real-world Simulator Result

. VideoGUI Eval. Full task Eval.
Model Settings i i i
High Plan. Mid Plan.  Action Success Rate  Rank (Arena) |
Orig. Query (V) 17.1 53.5 56.3 0 2.50
GPT-40[9] w. GT High Plan. 100.0 53.5 56.3 0 1.88
w. GT High & Mid Plan. 100.0 100.0 56.3 0 1.38

Table 13: Simulator Evaluation on VideoGUI’s PPT full tasks.

Full tasks are extremely

hard, SR. cannot provide 'uman planning provides

enough feedback. meaningful assistance
Model Settings YldEOGUI Eva.l. Subtask Eval.
Mid Plan. Action  Success Rate (%) Avg. Round |
Orig. Query (V+T) 53.5 56.3 20.0 54
GPT-40 191 o GT Mid Plan. 100 56.3 50.0 3.3

Table 14: Simulator Evaluation on VideoGUI’s PPT subtasks. o
Agent planning is usually

more redundant than
human

Mid-level planning improve
subtask significantly
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Error Analysis (Subtask)

o ¢ Presentation ! Presentation
Subtask: . Title o Title
On the first slide, draw Presencer Nr o

an orange diamond on

the top-left side;

Presentation N P Presentation
Title . A oPoR0 Title

GPT-40: Final output Failed to select the correct shape.
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